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Avinashilingam Institute for Home Science and Higher Education for Women
(Deemed to be University under Category A by MHRD, Estd. u/s 3 of UGC Act 1956)
Re-accredited with A++ Grade by NAAC. Recognised by UGC Under Section 12 B
Coimbatore - 641 043, Tamil Nadu, India

Tenth Short-Term Capacity Building Programme on
‘Microsoft Suite Essentials for Office Administration’

On 14" December 2023 at 9:30 a.m. — 09:45 a.m. inaugural session started with blessings
of God Almighty, Dr.T.S.Avinahilingam Ayya Avargal and Dr. Rajaammal P.Devadas Amma

Avargal with a prayer song.

g‘t Avinashilingam Ir,stitl.llte for Home Scierfce and Higiler Education for Women

gl 2 Deemed to be University Estd. u/s 3 of UGC Act 1956, Category A by MHRD

%‘gy Re-accredited with 'A++' Grade by NAAC .CGPA 3.65/4, Category I by UGC
L5 Coimbatore-641 043, Tamil Nadu, India

Tenth Short-Term Capacity Building Programme on

‘ Microsoft Suite Essentials for Office Administration ’

Inaugural Session
14.12.2023

WELCOME ADDRESS &
EVENT BRIEF

DR. K. RAMYA
NODAL OFFICER, AIU-AI-AADC

Dr. K. Ramya, Nodal Officer, AIU-AI-AADC, welcomed participants representing non-

teaching staff from various colleges and universities nationwide. The program aimed to enhance
skills, foster collaboration, and focus on skill development, especially in the Microsoft suite.
The first day of the program centered around Microsoft Word, emphasizing document creation and
management. Mrs. Priyanka, an experienced technical facilitator and guest lecturer, conducted the
sessions. Participants were introduced to various aspects of Microsoft Word, including the ribbon
interface, quick access toolbars, customization of the status bar, and efficient document-saving
procedures.

The program focused on providing essential skills and knowledge to navigate the Microsoft
Suite, recognizing its significance in the rapidly evolving technological landscape. Dr. Ramya
emphasized the role of efficient administrative officers in the overall functioning of educational
institutions. The curriculum was carefully designed to enhance daily operations and streamline
tasks, contributing to the overall efficiency of administrative duties.

Participants were encouraged to actively engage in discussions, ask questions, and
maximise learning opportunities. Dr. Ramya expressed gratitude to the management for their

support in deputing participants to the program. The fostering of an environment of shared learning,



collaboration, and camaraderie was emphasized, harnessing the power of knowledge for
institutional success.
As the nodal officer, Dr. Ramya extended heartfelt wishes for a productive and enriching
experience during the program. The structure of the three-day program was outlined, focusing on
Microsoft Word on day one. The participants were encouraged to participate actively, ensuring a
successful and rewarding learning experience.

The program set the stage for a collaborative and knowledge-driven environment, fostering

growth and success in the participating institutions.

Session I
14/12/2023 @ 11.00 am — 04.30 pm
Microsoft Word ( Document Creation)

Priyanka C
Technical Facilitator cum Guest Lecturer

The Microsoft Word training session, a part of the three-day capacity-building program
organised by Avinashilingam Institute for Home Science and Higher Education for Women,
Coimbatore, was conducted by Mrs. Priyanka, an accomplished professional with a diverse
educational background and extensive experience in interior designing, psychology, and MBA in
HR management. Mrs. Priyanka has previously delivered guest lectures at reputed institutions like
Karunya University, PPG College, and NGP College.

Dr. Ramya, the nodal officer, thanked Mrs. Priyanka for accepting the invitation to conduct
the program. The educational venture aimed to enhance the participants' skills in various software
tools, including Microsoft Word. Dr. Ramya highlighted the importance of efficient document
creation, formatting, and collaboration in professional settings.

Mrs. Priyanka commenced the Microsoft Word session by providing an overview of the
software's capabilities. She emphasized its significance in professional document creation,
including reports, applications, meeting agendas, resumes, memorandums, newspapers, and
business cards.

Mrs. Priyanka elucidated various features of Microsoft Word, such as text editing,
document formatting, spell checks, mail merging, headers, footers, and graphical insertions. She
also discussed the importance of page numbers, font customization, and document organization.

The session was structured to cover essential topics, starting with an introduction to the

Microsoft Word interface. Mrs. Priyanka covered creating and saving documents, toolbars,
formatting, styles, graphical presentations, page layouts, and collaboration tools. The participants

were encouraged to engage in the learning process actively.
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Mrs. Priyanka provided a step-by-step demonstration of Microsoft Word's interface,
explaining how to create, edit, and format documents. She discussed practical tips, shortcuts,
and the effective utilization of various tools within the software. Participants were
encouraged to follow along on their devices for hands-on learning.

The session included interactive elements, with participants given the opportunity to
ask questions and seek clarification. Mrs. Priyanka addressed queries, ensuring that
participants gained a comprehensive understanding of Microsoft Word.

As the session concluded, Dr. Ramya thanked Mrs. Priyanka for her insightful
presentation and expertise. Participants were encouraged to apply the newly acquired
knowledge in their professional roles, fostering efficiency and collaboration. The program's
success was attributed to the active participation of attendees and the valuable contributions
of Mrs. Priyanka.

The Microsoft Word training session set a strong foundation for the subsequent days
of the capacity building program, providing participants with essential skills for effective
document creation and management.

The second part of the Microsoft Word training session, focused on practical
demonstrations within the software. Participants were encouraged to follow along if they
had the software installed on their devices. Mrs. Priyanka emphasized the importance of
setting basic parameters, such as font size and header, before beginning any professional

document.
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Inserting Additional Text

= Téxt can be inserted in a document at any point using any of the following methods: S
Type Text: Shiraz Parveen P 21PHB...
= Put your cursor where you want to add the text and begin typing

Copy and Paste Text:

* Highlight the text you wish to copy and right click and click Copy, put your cursor where you want the text in the document
and right click and click Paste. OR Ctrl + C for copying and Ctrl + V for pasting.

Cut and Paste Text:

* Highlight the text you wish to copy, right click, and click Cut, put your cursor where you want the text in the document,
right click, and click Paste. OR Ctrl + X for cutting and Ctrl + V for pasting.

Drag Text:
* Highlight the text you wish to move, click on it and drag it to the place where you want the text in the document, 243 others
= You can also use the Clipboard group on the Ribbon.

Deleting Blocks of Text:
i ' Use the BACKSPACE and DELETE keys on the keyboard to delete text. Backspace will delete text to the left of the cursor and

Delete will erase text to the right. To delete a large selection of text, highlight it using any of the methods outlined above
and press the DELETE key.
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Microsoft Word Interface Overview:

Mrs. Priyanka provided an in-depth overview of the Microsoft Word interface, emphasizing
the Quick Access Toolbar, Ribbon Tabs, Groups, Dialogue Box Launch Buttons, Rulers,
Title Bar, and Zoom Slider. She explained how each element contributes to efficient
document creation.

Quick Access Toolbar Customization:

The Quick Access Toolbar was introduced as a customisable toolbar that allows users to
add frequently used commands for easy access. Mrs. Priyanka demonstrated how

participants could personalize the toolbar based on their preferences.
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Understanding Tabs and Ribbons:

Participants were guided through the nine tabs available in Microsoft Word — File, Home,
Insert, Design, Layout, References, Mailings, Review, and View. Mrs. Priyanka explained
that each tab offers specific tools and options related to different aspects of document

creation.



File Tab Functions:

The functions under the File tab, such as saving, closing, creating new documents, printing,
and customization, were discussed. Participants were shown how to access these functions
for efficient document management.

Document Opening and Renaming:

Mrs. Priyanka explained how to open documents through the File tab, either by selecting
recently opened files or navigating to a specific file location. Additionally, she
demonstrated the process of renaming a document for clarity and organization.

Status Bar Information:

The importance of the Status Bar at the bottom of the document was highlighted. Mrs.
Priyanka explained that it displays information about the current document, including page
number, column and line numbers, and word count.

Setting Margins:

Participants were guided on the significance of setting margins before starting a document.
Mrs. Priyanka drew parallels with the traditional practice of setting margins on a physical

sheet of paper before writing.
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Add Border at the Bottom of Your Document

To add a boarder at the bottom of your text or document you can simply use certain
special characters and then press enter:

S

Shiraz Parveen P 21PHB...

Border Type Special Character Result

| Press Shift+ hyphen (-)

If you require a very thin
underline (approx % inch)

If you want a comparatively
bold underline (approx 1.5
inch)

Insert double underline
border

If you want to draw a dotted
line

If you want to draw a zigzag
IK“'[I!'I‘

If you want a three line border
’ with two thin lines and a thick
f bold middle line

symbol thrice and hit the
| enter key |
| Press Shift+ Underscore ( _)

symbol thrice and hit the
| enter key |
Press Shift + equal to sign (=)

| three time and click enter
Press Shift+ asterisk sign (*)

| thrice and hit the enter key

| Press Shift + tilde (~)and hit
the enter key
Press Shift+hashtag (#)
symbol (#) and hit the enter

key
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Text Operations:
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Basic text operations, such as entering, moving, copying, deleting, finding, and replacing
text, were covered. Mrs. Priyanka emphasized the need to establish a clear margin before

performing these operations.



Participants were encouraged to practice the concepts learned by actively navigating
through Microsoft Word and applying the demonstrated features. Mrs. Priyanka provided
guidance and addressed queries, ensuring participants gained hands-on experience.

The Microsoft Word training session gave participants practical insights into using
the software effectively. Mrs. Priyanka's step-by-step demonstrations enhanced participants'
understanding, and the interactive nature of the session facilitated a dynamic learning
environment.

Next session of Mrs. Priyanka, delved into advanced document creation features,

including formatting, table manipulation, and spell-check functionalities.
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Document Formatting & Styles

@ Text Formatting: Text Selection, Fonts, Colors, and Sizes,
Advanced Text Effects

@ Paragraph Formatting: Alignment, Line Spacing, and Indents

@ Introduction to Styles for Consistent Document Formatting afz !
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Document Formatting:

Mrs. Priyanka highlighted the significance of document formatting, emphasising the
importance of setting margins, selecting page orientation (portrait or landscape), and
determining the paper size before initiating the document. She demonstrated how these
basic settings contribute to the overall presentation of the document.

Text Formatting:

Participants were guided through the Home tab options for selecting fonts, changing font
sizes, and applying text styles. Mrs. Priyanka explained the flexibility of choosing various
font styles and sizes based on the document's nature, whether it be a text-heavy document,

cover page, or business card.
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Alignment and Styles:
The importance of text alignment (left, right, center, justified) and the application of styles
(bold, italic, underline) were discussed. Mrs. Priyanka demonstrated how these formatting

tools enhance the overall visual appeal of the document.

Headers and Footers:

Detailed insights into the utilization of headers and footers were provided. Participants
learned how to include document information, such as file names, author names, and page
numbers, in headers and footers. The customization options for placing elements in

different sections of the page were also explored.
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Page Numbers:

The significance of page numbers in documents was highlighted. Mrs. Priyanka explained
how page numbers can be automatically inserted, customized, and positioned based on user
preferences. Participants gained insights into the versatility of page number placement,

either in headers, footers, or within the document margins.

Find and Replace:

The powerful find and replace feature was introduced, allowing participants to efficiently
locate and replace specific text throughout the document. Mrs. Priyanka demonstrated how
to use advanced options such as case sensitivity, whole word matching, and wildcard

characters for precise replacements.
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* If you want to replace at time only one word, then click replace command button

« |f you want to replace all word, then click “replace all” command button.

* Then after it will display message box as replace w'lﬂlSﬂEd.'

* Click ok button.

* If you want to find the text, and then click find tab button

* Write find word in the find word text box

* Click find next.

* Click ok when word flashes 241 others
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*word has finished searching the document “

V * Click close.
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Table Creation:

Mrs. Priyanka provided an in-depth tutorial on table creation. Participants learned how to
insert tables, adjust properties such as width and height, and customize individual cells. The
session covered merging and splitting cells, offering participants a comprehensive

understanding of table formatting.
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Spell Check:

The importance of spell-check functionality in creating error-free documents was emphasised.
Mrs Priyanka demonstrated how to use spell check to identify and correct misspelt words,
ensuring the overall quality and professionalism of the document.

This part of the Microsoft Word training session offered participants a deeper understanding of
document formatting and advanced text editing features; Mrs. Priyanka's detailed explanations
and practical demonstrations enhanced participants' proficiency in utilising these tools
effectively.

As the session continued, Priyanka demonstrated the different templates available in the
software and explained the importance of templates for efficient document creation.
Document Formatting:

The session emphasised the importance of setting document properties such as margins,
orientation (portrait or landscape), and size (A4, letter, etc.). Priyanka highlighted the use of
columns and page breaks for better document organisation.

Page Breaks:

Priyanka explained the significance of page breaks in breaking the continuity of page numbers.
Page breaks were demonstrated to start page numbering anew at specific points within a
document.

Participants faced challenges related to page numbering and formatting. Priyanka addressed
these issues individually, ensuring everyone could follow along. Some participants attended
the session from mobile devices, and efforts were made to provide instructions suitable for

various platforms.
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Tables and Illustrations:
The session covered the insertion of tables and illustrations into documents. Priyanka explained
the process of creating tables, adjusting their structure, and using illustrations such as pictures,
charts, and shapes to make the document more engaging.
8 @ & o
&

[llustrations, Pictures, and Smart Art: S

Shiraz Parveen P 21PHE...
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Symbols and Equations:
The session highlighted the insertion of symbols and equations, showcasing how to add
special characters and mathematical symbols to documents. Priyanka explained the use of

predefined symbols and equations, making the content more versatile.
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Symbols and Special Characters:

* Special characters are punctuation, spacing, or typographical characters that are not
generally
» available on the standard keyboard. To insert symbols and special characters:

Place your cursor in the document where you want the symbol
Click the Insert Tab on the Ribbon.
You will see the symbol button as illustrated (displayed as right end bottom of the ribbon).
Click the Symbols drop down button will display drop down list of symbols option. -
+ Clicking on any one of these will insert the symbol that you clicked on (at the insertion point). :1’ ;.
If Clicking on more symbols will display additional symbols as illustrator. W
If you click on special character tab within dialog box, display the list of speg 241 others

* Click oninsert button.

Now you will see in your document, selected symbol will be inserted.
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The training session aimed to familiarize participants with various text formatting features,
font styles, paragraph settings, bullets, and numbering. Additionally, the session covered table
insertion, merging and splitting cells, and inserting equations and symbols in Microsoft Word.

In the next session conducted by Ms. Priyanka aimed at providing a comprehensive
understanding of various features in Microsoft Word, with a focus on illustrations, signatures,
digital signatures, mail merge, page layout, and document protection.

Definition: Illustrations refer to graphical pictures, smart arts, or graphical pages included in a
document. Word allows the insertion of illustrations and pictures from online or saved images.
Process: Place the cursor in the document, go to the "Insert" tab, and choose "Pictures" to browse
and insert images. Additional features include cropping and resizing images.

Signature and Signature Line:

Adding Signature Line S

* Insert a signature line Insert a 5|gnatu re line Shiraz Parveen P 21PHB...
+ Click where you want the line. Jse the Signature Line command to insert a signature line with an X

+ Select Insert > Signature Line. document
* Select Microsoft Office Signature Line.

* In the Signature Setup box, 1. Click where you want the line.
* you can type a name in the

" 2. Select Insert > Si Li
* Suggested signer box. - R

Select Microsoft Office Signature Line
212 others

4. In the Signature Setup box, you can type a name in the Suggested signer box. You can also add a
title in the Suggested signer’s title box

5. Select OK. The signature line appears in your document

X




Importance of signatures in official documents.

Word allows the insertion of a signature line with details such as name, designation, and company
address. Digital signatures can also be added as pictures from devices or online.

SmartArt:

SmartArt is used for flowchart hierarchy level illustrations. Offers predefined work charts for
demonstrating hierarchies, processes, matrices, pyramids, etc. Different chart representations such

as clustered columns, 3D representations, and various chart types.
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Mail Merge:
Mail Merge is used for printing or emailing form letters to multiple recipients. Involves creating a
Word document and entering a recipient list, typically in Excel. Useful for producing multiple
letters, labels, envelopes, name tags, etc.
Mrs. Priyanka was explaining about the following in the next sessions.
e Page Border and Page Color
e Watermarks
e Side-by-Side Views,
e Page Layout
Password Protection:
Protecting confidential documents with password encryption. She emphasised the importance of

remembering the password, as there is no recovery option.
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Convert Word to PDF:
Explained two methods: "Save As" and "Print" using Microsoft Print to PDF. Converting Word

documents to PDF for easy sharing and viewing.
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The eminent resourse person also talked about some important shortcuts that can be used in the day
to day operations of MS Word. Those shortcuts are very useful for the administrative staffs and any

users for the smooth functioning of MS Word.



H @ E‘ @ & Pl Presenng

Shortcut keys

Document Shortcuts
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Shortcut keys

Document Shortcuts

Cl+N Create new dotument
Cul+$ Save document
cul+2 Undo last action
Cul+A Select all

f Start Spelichecker
Ctrl+F4 Clase current document
Navigation Shortcuts

Home: Go to start of line

Ctrl + Home Go to start of document
Page Down 6o to next page
Ctrl+Page Down  Go to next page [top]
[ Find (Navigation Pane)
Tab Go to next table cell

Clipboard Shortcuts

Cul+X o

cul+v Paste

Paragraph and Pagination Shortcuts
Enter New paragraph

Ctrl + Enter Insert Page Break

Shift + Enter New line in paragragh}
Ctl+Shift+ Enter  Insert Section Break
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End
Curl+ End
Page Up
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Mrs Priyanka also explained some examples of the creation of some important documents like

Curriculum Vitae and Appointment letters. Those examples are well explainable about the

importance of MS Word in daily life.
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Appointment Letter
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Day 1 session provided valuable insights into Microsoft Word features, enhancing participants'

understanding of document creation, formatting, and protection. Day 1 ended successfully with

interaction with participants. Participants were asked their queries, and the resource person

explained every question in an understandable manner. Participants provided their positive

feedback and comments.

On the first day of the Capacity Building Program received enthusiastic feedback from

participants. Dr. K. Ramya, Nodal officer, expressed gratitude for the numerous appreciations and

highlighted the importance of Microsoft Word in various professional roles.

Ramya emphasised the widespread use of Microsoft Word among support staff and college

teachers. Real-life examples illustrated the practicality of functions like find and replace.



Special thanks were extended to Priyanka for her passionate presentation. Participants were
encouraged to apply the knowledge gained, demonstrating with documents and replicating
exercises for better proficiency.

The session concluded with instructions for feedback submission and a reminder for the
next day's focus on Microsoft Excel. Dr. K. Ramya urged participants to approach the program
seriously, emphasising the importance of attendance, feedback, and post-assessment for certificate
issuance.

In conclusion, the Microsoft Word session set a positive tone for the program, fostering
active participation and a commitment to upskilling. Participants were appreciative, engaged, and

ready to implement newfound skills professionally.

Day 2
15/12/2023 @ 09.30 am — 04.40 pm
Microsoft Excel (Spreadsheet Applications)

Bishakha Anand
Project Coordinator cum Technical Trainer
Quadrasystems.net (India) Private Limited

The second day of the “Microsoft Suite Essentials for Office Administration” training
program, under the expert guidance of Bishakha Anand, Project Coordinator cum Technical
Trainer, Quadrasystems.net, provided an enlightening and enriching experience for all participants.
The session commenced with a comprehensive introduction to Microsoft Excel, emphasising its
pivotal role as a versatile spreadsheet program for recording, manipulating, and storing numeric
data. Bishakha stressed Excel's adaptability, allowing users to customise it to match their
preferences, making it an indispensable tool across diverse industries.
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Ms. Bishakha began the session with a detailed overview of the Microsoft Excel interface.
She highlighted the significance of the Ribbon, a central component that grants quick access to a
wide array of Excel commands. She further elucidated the Options dialogue window, which



empowers users to customise various elements, including the Ribbon, formulas, proofing, and
saving preferences.
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The Microsoft Excel training session led by Bishakha covered various aspects of Excel
functionality, providing participants with valuable insights and hands-on exercises. The session
began with a detailed discussion on cell formatting, including font options, borders, and alignment
settings.

Bishakha demonstrated the use of keyboard shortcuts for actions like copy-paste and
accessing dialog boxes. The Flash Fill feature was highlighted, showcasing its application in
pattern-based data manipulation. Bishakha shared practical examples, emphasizing the need for
caution and consistency when using Flash Fill.
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A special focus was given to Microsoft Excel's alignment options, including text direction,
font styles, and shading. Bishakha explained the use of merge cells and demonstrated how to
utilize the alignment settings for various formatting requirements efficiently.

The trainer addressed queries from participants, clarifying doubts about applying fractions,
date calculations, and text case conversions. The importance of the OK button in applying changes
was emphasised, ensuring that modifications take effect only upon confirmation.

Bishakha also covered the replace feature, showcasing its functionality and providing the
Ctrl+H shortcut for quick access. The session concluded with a demonstration of how to
simultaneously apply a specific format to multiple sheets, streamlining the formatting process for
large datasets.
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Participants were encouraged to explore Excel's capabilities through additional online
resources and tutorials. The interactive nature of the session, coupled with practical examples,
enabled participants to grasp Excel's functionalities effectively.

In summary, the Microsoft Excel training session proved to be informative and engaging,
equipping participants with valuable skills to enhance their spreadsheet management and data
manipulation capabilities.
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Next session focused on covering Excel's data formatting and alignment features.
Bishakha provided detailed insights into various options available for formatting data, including
fonts, borders, colours, and essential keyboard shortcuts.
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Bishakha demonstrated how to modify the number display, including using a thousand
separators and decimal places. Negative numbers can be formatted to appear in red for better
visual representation.

Bishakha covered advanced number formatting options, such as currency, accounting, date
formats, and percentages. Scientific notation and fraction representation were also explained,
providing a comprehensive overview of numeric display options.
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The training covered the option to treat numbers as text, preventing any automatic
calculations.

Bishakha actively engaged with participants, addressing questions and concerns about
Flash Fill, advanced formatting, and alignment settings. She clarified the significance of
maintaining data consistency for optimal results.

This session provided a comprehensive understanding of Excel's data formatting and
alignment features. Participants gained practical insights into enhancing the visual appeal of data
and automating tasks through Flash Fill. The training laid a solid foundation for subsequent
modules, ensuring participants are well-equipped to utilize Excel's powerful capabilities.

Advanced Excel Features
Bishakha introduced additional formatting options in this session. Some of them are,

v" Shrink to Fit:

She explained the "Shrink to Fit" option, where text adjusts itself to fit within the cell without
using the given fonts. Emphasized that changes are applied only after clicking the OK button.

v' Wrap Text:
She reiterated using "Wrap Text" to prevent text overlap when dealing with merged cells. She also
demonstrated how wrapping text helps maintain the structure of the data.

v" Merge Cells:
She introduced the "Merge Cells" feature and demonstrated how it combines cells into a single,
more extensive cell. She highlighted the importance of being cautious when using merged cells to
avoid potential formatting issues.

v" Text Direction and Font Options:
She discussed the option to change the text direction, allowing users to write from left to right or
right to left. Also demonstrated how to set the text direction based on specific requirements.
This session also Explored font-related features such as bold, italic, regular, and font size
adjustments. She showcased how to change the color of the font and customize various font
attributes.

v Grouping Sheets and Sheet Customization:

Bishakha explained the process of grouping sheets to perform actions simultaneously on
multiple sheets. She also showcased sheet customization options, including tab color and sheet
renaming.

Bishakha actively engaged with participants during Q&A sessions, addressing queries
about date calculations, lowercase and uppercase conversions, and replacing text. Practical
examples were provided to ensure a hands-on understanding of the concepts.
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In the next session, the speaker, Bishakha, discusses various features and functionalities within
Excel, such as sorting and filtering data, conditional formatting, and customizing the ribbon.

» Sorting and Filtering:

Some Important options available in this options are,
e Sorting data in ascending or descending order.

e Filtering data based on specific criteria.

e Using the filter option to selectively display data.

» Conditional Formatting:
Bishakha explained conditional Formatting as highlighting cells based on specific conditions (e.g.,

values less than 40 in red). She also demonstrated using colour scales, data bars, and icon sets to
represent data visuall.
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» Creating custom rules for conditional formatting.
e Top and Bottom Rules:
Identifying and highlighting the top or bottom values in a dataset (e.g., top 10).
e Data Bars:
Representing numerical values using visual bars.
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» Customizing the Ribbon:

Managing and customizing the ribbon in Excel for personalized use. The session also
touches upon the importance of keeping data in table format for easy application of
formulas and filters. Additionally, the speaker emphasizes the benefits of conditional
formatting in visually analyzing and interpreting data.

Customizing the Excel Ribbon:

Bishakha explains how to customize the ribbon in Excel. Users can add features they
frequently use by customizing the ribbon. The process involves going to the "File" menu,
selecting "Options," and choosing "Customize Ribbon." New tabs or features can be added,
and existing ones can be rearranged.

Developer Tab:

Bishakha mentions the "Developer" tab, which might be initially hidden and needs to be

activated in the ribbon customisation.

In the afternoon session, Bishakha explains converting text to lowercase and uppercase in

Excel. She demonstrates using formulas like =LOWER() for lowercase and =UPPER() for
uppercase. She explains the =PROPER() function to capitalize the first letter of each word in a
sentence.

3:05 PM | Microsoft Suite Essentials for Office A...

Bishakha also covered basic mathematical formulas in Excel, such as addition, subtraction,

multiplication, and division. She introduces the concept of order of precedence (BODMAS) and
explains the use of brackets and exponents in formulas. Some of the other options she discussed

are,

Insert Function Feature:
It Demonstrates the use of the "Insert Function" feature in Excel. It shows how to insert the
SUM function from the Math and Trig category.

Freezing Cells with Dollar Sign:

Bishakha explains the importance of the dollar sign ($) in freezing cells. It Shows how to
freeze a cell by adding a dollar sign before the row and column references, allowing for
easy replication.

20



» Editing Formulas:
Bishakha demonstrates how to edit formulas in Excel. She provides an example of editing a
formula to multiply a range of cells by a fixed number. The session covers a variety of
Excel functions, mathematical operations, and practical tips for efficient data manipulation.

In the next session, Bishakha is explaining the concept of concatenate in Excel,
demonstrating how to join or concatenate text in different cells using the CONCAT function. She
also discusses other Excel functions like COUNTIF, COUNTBLANK, SUMIF, and SUMIF with
conditions.

Bishakha also introduces pivot tables in Excel. She demonstrates how to create a pivot
table to organize and analyze data, especially for presentations to senior management. The
example involves arranging data by gender, class, and marks obtained in semester one.
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The session emphasizes the importance of using the tabular form in field settings to present
the data more clearly in the pivot table. Bishakha explains the importance of refreshing data in
pivot tables, especially when new data is added. She demonstrates how to change the data source
for pivot tables, allowing for easy updates when dealing with different data sets.

Up next, Bishakha was explaining the concept of VLOOKUP in Excel. In this session,
participants are interacting with Bishakha, asking questions, and seeking clarification on various
Excel-related topics.

VLOOKUP: Bishakha introduces the VLOOKUP function. She illustrates its usage by
demonstrating how to match and retrieve data from two different tables based on a common
identifier (in this case, the student names). The VLOOKUP function is used to search for a value in
one table and retrieve corresponding information from another table.
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The session was an interactive one, where participants ask questions and seek clarification
on topics such as conditional formatting and specific Excel functionalities.

The session concludes with participants expressing their understanding, and Bishakha ensures that
doubts are addressed.

This spreadsheet application session led by Bishakha, has received overwhelming praise
from the participants, as expressed in the concluding remarks by Dr. K. Ramya, the Nodal officer.
The participants highlighted the patience and dedication exhibited by the instructor from the early
morning, fostering a sense of mutualization and a positive learning environment.

Dr. K. Ramya emphasized the practicality of the session, acknowledging that participants
actively engaged and learned through interactive discussions. The participants appreciated the
relevance of the training to their daily tasks and expressed eagerness to apply newfound
knowledge.

Looking forward, the report outlines plans for future sessions, including a PowerPoint
session led by Bishakha and additional topics on OneDrive, Microsoft Teams, and email
management. The organizers aim to cover topics essential for support staff in their professional
roles.

The report concludes with a call for participants to provide feedback through the posted
form and emphasizes the importance of attendance and active participation for the upcoming post-
assessment. Overall, the workshop appears to be successfully fulfilling its objectives, providing
valuable insights and practical knowledge to the participants.
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Day 3
16/12/2023 @ 09.30 am — 12.40 pm
PowerPoint Design and Collaboration

Bishakha Anand
Project Coordinator cum Technical Trainer
Quadrasystems.net (India) Private Limited

Bishakha started this session with a presentation on PowerPoint skills, emphasizing its
usefulness not only in official settings but also in everyday life. She highlighted the significance of
presentation skills in expressing ideas effectively, using visual elements such as pictures and fonts
to make presentations more attractive.
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Opening a PowerPoint Presentation:
Bishakha demonstrated how to open PowerPoint by searching for it in the search tab. She
then explained the various options available, including new presentations and existing ones.
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Saving a Presentation:

She covered the basics of saving a presentation, emphasizing the importance of choosing a
location and providing a name. Bishakha demonstrated the process of saving a presentation and
discussed the quick access toolbar for efficient usage.

Ribbon and Tabs Overview:

Bishakha introduced the ribbon area, explaining its tabs and groups. The ribbon includes
various tabs such as Home, Insert, Draw, Design, Transition, Animation, Slideshow, Record, and
Review. Each tab consists of different groups offering multiple features.

Designing Slides:
She proceeded to discuss the design aspect, focusing on the Design tab. Bishakha

demonstrated how to change the theme and variant to enhance the visual appeal of the presentation.

She showcased the transformation of a basic slide into an attractive one using different themes and
variants.
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Inserting New Slides:

The presenter explained how to insert new slides and choose different types based on
content requirements. Bishakha demonstrated adding a title and content slide for discussing the
types of fruits.
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SmartArt Usage:

Bishakha introduced SmartArt as a tool to make presentations more engaging. She
demonstrated how to use SmartArt to create visually appealing representations, such as cycles, and
explained the process of editing content within SmartArt.

24



Adjusting Slide Elements:

The report covered the manipulation of slide elements, including resizing, aligning, and dragging.
Bishakha explained the importance of alignment using dotted lines and showcased how to modify
the size and orientation of elements.

Inserting and Editing Text Boxes:
She highlighted the need to use text boxes on blank slides for manual editing. Bishakha
demonstrated how to insert text boxes, adjust their size, and write and edit content.

Bishakha effectively engaged the audience, ensuring clarity on each step of the process. Overall,
her session serves as a valuable guide for individuals looking to enhance their PowerPoint
presentation skills in both personal and professional settings.

In the next PowerPoint presentation training session, it is focused on enhancing participants' skills
in creating engaging and visually appealing slides. The session covered topics such as inserting
text, using SmartArt, inserting pictures, and understanding various slideshow features.

Inserting Text:

The trainer, Bishakha, demonstrated the process of inserting text into slides. Participants learned
how to add bullet points, change text styles, and adjust formatting. A key takeaway was the
importance of concise and visually appealing text.

Inserting Pictures:

The session covered the process of inserting pictures into slides. Bishakha highlighted the impact
of visuals in presentations and demonstrated how to add pictures from both local devices and
online sources. Participants also learned about cropping and adjusting picture sizes.

Slideshow Features:

Participants were introduced to essential slideshow features. Bishakha explained the shortcut of
using the Alt key to navigate between tabs quickly. The slideshow button and options such as
presenting from the beginning, the current slide, or a custom selection were discussed. The
continuous loop feature was also demonstrated.

Customizing Slideshows:

Bishakha guided participants on how to customize slideshows, allowing them to choose specific
slides for presentation. The importance of setting slide timings for a seamless presentation was
emphasized. Participants learned to control the duration of each slide.

Recording Slide Timings:
The training covered the process of recording slide timings. Participants discovered how to set
specific durations for each slide, ensuring a well-paced and timed presentation.

The session encouraged participant interaction, with Bishakha addressing queries and ensuring
everyone's understanding. Participants actively practiced the demonstrated techniques, creating
their own slides and inserting elements.

Participants expressed satisfaction with the training, commending Bishakha's clear explanations
and hands-on approach. The interactive nature of the session facilitated a better grasp of
PowerPoint's features.
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The next session conducted by Bishakha, focusing on various features available during a slideshow
and techniques for image formatting.

Slideshow Features:

Full Screen Mode: Bishakha highlighted the importance of the full-screen button during
presentations. Even in full-screen mode, certain options like left-click and right-click are
accessible.

Navigation During Slideshow: Bishakha explained the options available for selecting slides,
emphasizing the convenience of an Optical Mouse for changing slides without using the
laptop keyboard.

Pointer and Annotation Features:

Laser Pointer: Demonstrated the use of a laser pointer for highlighting specific points on
slides during presentations.

Pen Feature: Explained the pen feature, allowing users to write or draw on slides with
various color options.

Highlighter: Showcased the highlighter option for emphasizing text or content on slides.
Eraser: Discussed the use of the eraser tool to remove annotations.

Magnification and Thumbnail Feature: Explored the magnify option, allowing users to
focus on specific elements of the slide, and the thumbnail feature for a quick overview of
all slides.

Exiting Slideshow: Bishakha demonstrated how to exit the slideshow using the Escape key.

Bishakha engaged the participants in a question-and-answer session, ensuring clarity on slideshow
features and functionality.

Image Formatting and Grouping:

Inserting and Editing Images: Illustrated the process of inserting images into a presentation,
including the options for editing and resizing.

Text Box and Formatting: Added a text box to the presentation and showcased formatting
options, emphasizing the visual appeal of the content.

Grouping Images: Bishakha explained the importance of grouping images, allowing them
to move together. Participants were guided on how to group objects for efficient formatting.

Bring Forward and Send Backward: Clarified the use of these options in the Picture Format
tab to control the layering of images.

The next part focuses on a session conducted by Bishakha, covering advanced PowerPoint features
and techniques for image formatting. The session included insights into grouping objects, adjusting
object order, and modifying images for background effects.

Advanced PowerPoint Features:

% Grouping and Ungrouping Objects:

Bishakha began by discussing the importance of grouping objects for efficient
manipulation.Participants were guided on how to ungroup objects and perform individual
actions on them. Bringing Objects Forward and Sending Backward:
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Demonstrated how to bring an object forward or send it backward in the layer order.
Explained the use of the "Bring Forward" and "Send Backward" options in the Picture
Format tab.Grouping Images for Unified Movement:

IMlustrated the process of grouping images, ensuring they move together and maintain their
relative positions.

Background Modification and Transparency:

Explained how to adjust transparency, blur, and other formatting options for creating
visually appealing backgrounds. Emphasized the play of transparency in achieving a
background effect.

Adding Background to Slides:

Bishakha demonstrated how an image can serve as a background for a title slide.
Participants were shown how to play with transparency, blur, and other effects to enhance
the background.

Grouping Text and Image:

Highlighted the option to group text and image together, allowing for seamless movement
and formatting.

Participants engaged in a question-and-answer session to seek clarification on advanced

features and image formatting. Specific queries included removing the background of a picture and
the process of adding background lighting.

Advanced PowerPoint Features - Tables, Charts, and Multimedia

In this session, focus was on advanced PowerPoint features such as table creation, chart

development, and multimedia integration. The participants received insights into editing tables,
creating charts, and adding multimedia elements for more dynamic presentations. Participants were
shown how to customize the chart by defining the data series and labels.

Multimedia Integration:

*
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Inserting Videos:

Bishakha demonstrated the process of inserting videos into PowerPoint slides.
Participants learned how to download and play videos directly within a presentation.
Inserting Stock Images:

Creating Charts and SmartArt Graphics:
Participants were reminded of the options to create charts and insert SmartArt graphics to
enhance visual representation.
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Exploring Advanced PowerPoint Features - Multimedia Integration and File Insertion
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The session particularly delved into multimedia integration, file insertion, and efficient ways to
manage heavy Excel files within a presentation.

Slideshow Tools Highlight:

Bishakha highlighted the use of various tools during a slideshow, such as laser pointing,
highlighting, and pen options, emphasizing the importance of effective presentation skills.

% SmartArt Graphics:
The incorporation of SmartArt graphics was discussed, showcasing its relevance in
transforming simple bullet points into visually appealing representations.
¢ Cameo Feature for Video Insertion:
Participants were introduced to the Cameo feature, enabling them to record and insert
videos directly into PowerPoint presentations.
% Table and Chart Insertion:
Bishakha demonstrated the insertion of tables and charts, showcasing their relevance in
data representation.
File Insertion:

% Inserting Existing Excel Tables:
Participants raised queries regarding the insertion of existing Excel tables into PowerPoint
slides. Bishakha demonstrated the process of inserting an existing Excel table into a
PowerPoint slide by using the "Object" option.

% Linking Excel Files and YouTube Videos:
Bishakha explained how to link Excel files as objects in a PowerPoint slide, allowing users
to access the original file during the presentation. The possibility of inserting YouTube
links was also discussed, offering a seamless transition from the presentation to external
resources.

% Transitions and Animations:
The session covered transitions between slides, demonstrating effects like split, push, and
bars. Bishakha emphasized the importance of selecting engaging transitions to capture
audience attention.

TITLE LOREM IPSUM DOLOR SIT AMET
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% Animation Features:
Participants were introduced to animation options, enabling them to add dynamic elements
to individual objects or entire slides. Bishakha showcased the application of sound effects
during transitions to enhance audience engagement.
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The session continued with practical tips for creating engaging presentations. Participants
were encouraged to experiment with transitions, animations, and multimedia elements to deliver
impactful and memorable presentations. A concluding thank-you slide was emphasized, providing
closure to a well-crafted presentation.

% Screen Clipping and Screenshot Integration:

Bishakha demonstrated the screen clipping feature, allowing participants to capture and

insert specific parts of their screens directly into PowerPoint slides. This feature proves

invaluable for presenting live screenshots during a presentation. Participants were guided
on how to insert screenshots from external files, facilitating the integration of pre-captured
images into their presentations. The process involved navigating to the desired location and

using the "Insert Screenshot" feature.
@

File  Home Insert Diaw Desion Teanstions Ao

ol Review  View Heln  drcechilih

0 )| §=)
Apple Autumn Background

=

Animals

b [ I
==
= )
el el £
Beach Birds Birthday Cake
e o ] —— — ] e
¥
¥
[0 togishtinds) T Accessibliy: Investigate 3 Lve B BB T -—

Advanced Chart Creation:

Bishakha delved into advanced chart creation, emphasizing the importance of
exploring various chart styles and types to suit specific data presentation needs. Participants were
encouraged to experiment with different charts, considering their data context. The session
highlighted how data modifications in Excel tables automatically reflect in PowerPoint charts. This
dynamic synchronization ensures that any alterations in the raw data seamlessly update the
associated charts.
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Custom Slideshows and Navigation:

% Custom Slideshow Creation:
Participants learned to create custom slideshows, allowing them to tailor presentations
based on specific audience needs. The process involved skipping or including selected
slides to enhance presentation flexibility.

¢ Custom Slideshows During Presentation:
Bishakha demonstrated how to activate and present custom slideshows during the actual
presentation, providing a seamless way to skip or emphasize specific content based on
audience interactions or preferences.
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Printing Options and Paper Efficiency:

The session covered the print options in PowerPoint, addressing the need for efficient paper
usage. Participants learned how to customize print settings to include multiple slides on a single
page, reducing paper consumption while maintaining clarity.

% Print Preview and Page Layouts:

Bishakha guided participants through the print preview feature, allowing them to visualize

the print layout before finalizing it.

The session continued with a comprehensive understanding of advanced PowerPoint features,
including screenshot integration, dynamic chart creation, custom slideshows, and printing
optimizations. Participants were empowered to create engaging and tailored presentations,
ensuring effective communication with their audiences.
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Excel Split Option:

Bishakha discussed the "split" option in Excel's "View" tab. Explained how splitting the
window can be useful for simultaneously viewing different sections of a large dataset. She also
demonstrated how to split the Excel sheet into two windows for better data comparison.

The additional information provided by Bishakha further enhances participants'
understanding of Excel functionalities. The split option is highlighted as a valuable tool for
managing and viewing different parts of a large dataset simultaneously.

In conclusion, the training session successfully empowered participants with the skills
needed to elevate their PowerPoint presentations, making them more impactful and visually
appealing.

The hands-on demonstration allowed for practical learning, empowering participants to
create more dynamic and engaging presentations.

Day 3
16/12/2023 @ 1.30 pm to 4.45pm
Microsoft Teams & One Drive

Praveen Poulose E
Engineer - Cyber Security Group
Quadrasystems.net (India) Private Limited

Avinashilingam Institute for Home Science and Higher Education for Women
Deemed to be University Estd. u/s 3 of UGC Act 1956, Category A by
MHRD Re-accredited with 'A++' Grade by NAAC .CGPA 3.65/4,
Category I by UGC Coimbatore-641 043, Tamil Nadu, India

Tenth Short-Term Capacity Building Programme on

‘ Microsoft Suite Essentials for Office Administration’

16.12.2023

Day 3 — Session II

Microsoft Teams & One Drive Ramya MBA

PRAVEEN POULOSE E
ENGINEER - CYBER SECURITY GROUP
QUADRASYSTEMS.NET (INDLA) PRIVATE LIMITED

31



Nodal Officer, Dr. K. Ramya introduced Praveen Poulose, who will guide the audience
through Microsoft Teams and OneDrive. Praveen will cover essential tools for support staff to
enhance workplace productivity.

Praveen greeted the audience and mentioned the agenda for the session, focusing on
Microsoft Teams and OneDrive. He emphasized the importance of these applications for
productive and effective work.

Microsoft 365 Overview:

Praveen briefly explained Microsoft 365 as a cloud-based platform with software bundles
like Word, Excel, PowerPoint, Teams, and OneDrive. He highlighted the transition from offline
applications like Office 2016 to the cloud-based Microsoft 365.
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Microsoft Teams:

Praveen delved into Microsoft Teams, describing it as a business communication software
facilitating team collaboration. He discussed its main use cases, such as instant messaging,
scheduled meetings, voice/video calls, and file sharing.

HOWB Ty the newTeams

T Training day 1 Posts Fies Nores

| praveen poulose
\

-

Welcome to your new channel

) (%)

Ranjitha P S Lingesh VARUN DUBEY
i g

%

S &

161 others

Sirisha Tadigotla
g/

Alternative Solutions to Microsoft Teams:
Praveen engaged the audience by asking for alternative collaboration applications, and participants
mentioned Zoom, Google Meet, Skype, and others.

OneDrive Overview:
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Praveen introduced OneDrive as a Microsoft file hosting service, emphasizing its use for file
backup, sync, and accessibility from anywhere. He discussed the importance of cloud-based
backup in protecting against ransomware attacks.
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Alternative Solutions to OneDrive:
Participants mentioned alternatives like Google Drive, Dropbox, Sync, Mega, and others.

Microsoft Teams Demonstration:

Praveen demonstrated how to log in to Microsoft Teams through the web-based application. He
also showed how to install Microsoft Teams on the desktop by accessing the Microsoft 365 apps.
Praveen mentioned that the session would cover various aspects of Microsoft Teams, including
creating teams and channels, starting conversations, scheduling meetings, finding content, creating
notifications, checking outlets, and exploring common settings.

summary.

Microsoft Teams Installation and Group Creation

Praveen Poulose conducted a detailed demonstration on the installation and group creation process
using Microsoft Teams. The primary focus was on the seamless installation of Microsoft 365
applications and the subsequent creation of teams and channels for effective collaboration. Praveen
explained the process of installing Microsoft 365 applications after logging into office.com. He
emphasized the minimal storage space required for the online package and how it efficiently
downloads from the cloud. The presenter highlighted the bundling of all Microsoft 365
applications into a single package, making it convenient for users to install multiple applications
simultaneously.

Praveen demonstrated the installation of Microsoft Teams, emphasizing its availability as
part of the Microsoft 365 app bundle. He showcased how Teams could be accessed via a browser
without the need for a separate installation on a system or mobile device. The presenter explained
the option to download the mobile app and provided guidance on the installation process, including
the use of a specific email ID for mobile login.

Microsoft Teams Group and Channel Creation:

Praveen illustrated the process of creating teams within Microsoft Teams. He highlighted
the three available templates for managing projects, events, or general communication within an
organization.

The presenter walked through the steps of creating a team, specifying the project name,
description, and template. The demonstration continued with the creation of channels under the
newly formed team, showcasing the flexibility to create channels for specific topics or events.
Praveen explained the importance of setting privacy options for groups, distinguishing between
private and public groups based on domain access.

The presenter provided insights into managing team members, including the addition of
new members, assigning roles, and adjusting privacy settings.
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He also encourage users to explore the flexibility of channel creation for specific topics or
events. Highlight the importance of privacy settings when creating groups to ensure secure
collaboration.
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Member Permissions

Praveen highlighted the importance of setting member permissions within a group. Members can
be granted various permissions, such as creating and updating channels, removing apps, uploading
apps, and removing tabs. The session emphasized the need for understanding and configuring these
permissions based on the specific requirements of the group.

Analytics

The training covered analytics features, providing insights into group engagement. Praveen
demonstrated how to view reports on active members, message engagement, and other relevant
metrics. The analytics function is crucial for understanding group dynamics and ensuring effective
communication.

Tagging and Mentioning

The session covered the use of tags to mention specific members in messages. Praveen showcased
how tagging facilitates communication by notifying individuals about messages relevant to them.
Tagging is particularly useful in large groups where direct communication is necessary.

Creating and Broadcasting Messages

Praveen explained the process of creating and broadcasting messages within a channel. He
demonstrated how to include subject lines, descriptions, meeting locations, and times. File
attachments, emojis, and stickers can enhance the communication experience.
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Additional Message Options:
% Pinning: Messages can be pinned for easy identification, ensuring important information

remains visible.

Saving: Users have the option to save messages for future reference.

Mark as Unread: Members can mark messages as unread, allowing them to revisit and

respond later.

% File Sharing and Collaboration

The training covered the collaborative aspects of Microsoft Teams, focusing on creating, editing,

and sharing files within a group. Praveen demonstrated how multiple users can simultaneously

work on the document, emphasizing real-time collaboration.
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File Management:

Praveen highlighted the significance of integrating Microsoft Teams with other applications like
Excel for seamless collaboration. He emphasized the convenience of working on files offline and
discussed the importance of the auto-save feature. The demonstration showcased how files can be
synchronized on OneDrive for automatic saving and easy access.

Version History:

Participants were informed about the version history feature, enabling them to track document
changes over time. Praveen explained how this feature helps prevent confusion and facilitates
collaboration by providing insights into modifications made by team members.

Collaboration and Permissions:

Notes and Apps:

The Teams application allows users to add notes and integrate various apps for enhanced
functionality.Praveen illustrated how users can create notes within the application and add custom
tabs for specific tools or websites.
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Live Meetings:

The training included a practical demonstration of scheduling and conducting live meetings within
Teams. Praveen showcased the meeting interface, chat functionality, file sharing during meetings,
and the option to invite both team members and external participants.

Meeting Controls:

Participants were guided through meeting controls, including chat, people, raise hand, and
reactions. The importance of recording meetings for reference and sharing was highlighted, along
with the customization of audio and video settings.

Visual Effects and Backgrounds:
Praveen covered the visual effects and background options available during meetings, providing a
more dynamic and engaging meeting experience.

Settings and Configurations:
The session concluded with a walkthrough of settings, including device configuration options,
background settings, and audio preferences.

Record Automatically Feature:
The 'Record Automatically' feature was explained to prevent the omission of recording sessions,
ensuring important content is captured for future reference.

Invitations and Chat Integration:

Inviting participants through Teams and Outlook was demonstrated, ensuring that attendees
receive all relevant details. The integration of chat and live call options was discussed, showcasing
the convenience of direct communication within the Teams platform.
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Editing and Updating Meetings:

Praveen demonstrated the editing options for scheduled meetings, allowing for adjustments to date,
time, and attendees without creating a new meeting. Attendees receive updates automatically,
simplifying the process of notifying changes.

Joining Meetings with ID:

Participants were educated on joining meetings using the meeting ID and password, offering a
quick and direct method of access without relying on links.

Webinars and Live Events:
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A brief overview of scheduling webinars and live events was provided, emphasizing the
differences in attendee and presenter settings compared to regular meetings.

The other topics discussed are,
% Muting Participants in Teams Meetings
% Handling Participants Leaving Meetings
% Navigation and Message Management
¢ General Settings and Privacy
% Notification Settings
7/

¢ Teams App Permissions

X/

¢ File Handling and Integration

Comparison between Microsoft Teams and Google Meet:

The trainer provided insights into choosing between Microsoft Teams and Google Meet. He
emphasized that the choice depends on the organization's needs and licensing. For business
applications, Praveen recommended Microsoft Teams due to its centralized control and bundled
software.

Introduction to OneDrive:

Transitioned to OneDrive, describing it as a cloud storage solution for backing up and syncing data
across devices. He showcased the online and desktop versions of OneDrive and explained the
benefits of having a cloud-based storage solution. He provided a step-by-step demonstration of
signing in to the OneDrive desktop app and explained its functionalities. He also illustrated the
options for opening folders, accessing the recycle bin, and managing online files directly from the
desktop app.
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File Syncing and Status Icons:

Demonstrated syncing files between local devices and the cloud, using the green checkmark icon
to indicate successful synchronization. He explained the various status icons, such as the cloud
symbol, user icon (for shared files), and the colored indicators showing the syncing status.

Shared Files and Permissions:

Showcased the "Share" option, enabling users to share files with others by specifying permissions
and access levels. Explained the importance of the user icon, indicating shared files, and how to
manage access by viewing and modifying permissions.

Always Keep on This Device and Free Up Space:

He Explained the difference between "Always Keep on This Device" and "Free Up Space" options.

"Always Keep on This Device" ensures the file is stored locally and does not sync to the cloud,
conserving local storage. "Free Up Space" allows users to reclaim local storage by keeping the file
in the cloud while freeing up space on the device.

File Management:

He demonstrated the process of viewing files online directly from the OneDrive application,
providing a quick preview of document content. Discussed the "Recycle Bin" feature, which
allows users to recover recently deleted files.

Disconnecting from OneDrive:

Covered the steps to disconnect from OneDrive, offering insights into when users might choose to
do so.

Praveen Poulose invited questions and clarified doubts from participants. The training
successfully equipped users with practical skills for efficient OneDrive file management, ensuring
optimized synchronization, secure sharing, and version control. Participants left with a
comprehensive understanding of how to leverage OneDrive to enhance productivity while
efficiently managing their files.

The concluding session marked the end of a comprehensive training program led by Praveen
Poulose, focusing on OneDrive and Microsoft Teams. The session commenced with Praveen's
confirmation of the completion of the training content.

The Microsoft Teams training session conducted by Praveen Poulose successfully equipped
participants with practical knowledge about leveraging Teams for effective collaboration and
communication. The hands-on demonstrations provided a clear understanding of key features,
ensuring participants can enhance their productivity using the application.

The Teams Training Session proved to be informative and practical, equipping participants
with the skills to schedule, customize, and manage meetings efficiently within Microsoft Teams.
The step-by-step guidance on various features empowers users to make the most out of Teams for
their collaborative efforts.

Dr. K. Ramya invited participants to seek clarifications on the session, and appreciations
flooded the chat box, showcasing the success of the program. Ramya formally thanked Praveen for
dedicating his weekend to deliver insightful sessions. Praveen, in turn, thanked the participants and
acknowledged the support received from their management.

In the final moments, participants expressed gratitude and requested Praveen to switch on
the camera, indicating a positive and interactive atmosphere. The session concluded with
instructions for submitting feedback and assessments.
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Participants List

S.No Name Designation Institution/ Organization Name
1 N.P.Kumar Lab Technician Sona College of Technology
2 Priyatharsini V C Data Entry Operator Kongu Engineering College
3 Kurella Rekha Rajeswari Junior Assistant Sasi institute technology and engineering
4 S Ranjithkumar Lab Assistant Kongu Engineering college
5 Nayana.D Clerk Sambhram Institute of Technology
Rajiv Gandhi Institute of Petroleum
6 Varun Dubey Assistant Grade-I Technology
7 K.Gowri Data Entry Operator Kongu engineering college
Kongu Engineering College (autonomous)
8 Gokulkumar S Technical Assistant Perundurai
Senior Technical
9 Senthilkumar N Assistant Kongu Engineering College
10 Avinash jain M Assistant Instructor JNN College of Engineering
11 K.N.Anandhakumar Technical Assistant Kongu Engineering College
12 Arati Tikare Computer lab Instructor JNN College of Engineering
13 R.yuvaraj Lab Technician Sona College of Technology
14 Sunila G D Mechnic JN N College of engineering
15 M kannan Lab Tech Sona college of technology
16 Yamunadevi G Technical Assistant Kongu Engineering College
17 V.Velu Lab Technician Sona college of technology
18 Sumamma B N Lab Technician Sambhram Institute of Technology
19 Kumaresan C Tr lab technician Sona College of technology
20 S.SENTHIL KUMAR Data Entry Operator Kongu Engineering College
21 Soundarya P Programmer KSR educational Institutions
22 Arockia Mary J Lab Assistant Providence college for women
KSR Institute for Engineering and
23 S. Renupriya Lab Assistant Technology
24 D.Dhanalakshmi Lab Technician Sona College of Technology
25 SINDHU.V Lab Instructor KSR Education and Institutions
Vishnu Institute of Pharmaceutical
26 Rajani.MVN Librarian Education & Research
27 Nithiyambal.V Assistant administration Sona College of Technology
28 Sriram Technical Assistant kongu engineering college perundurai
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29 D sathishkumar computer lab assistant Kongu Engineering College, Perundurai
30 Panneerselvam J System administrator Sona College of technology
31 Priya A Lab instructor st.joseph Engineering College
32 Shailaja B Lab Instructor St Joseph Engineering College
Rajarambapu Institute of Technology,
33 Swati Narendra Kekhalekar Library Assistant Rajaramnagar.
Sasi Institute of Technology and
34 B Srinivasu Asst Librarian Engineering
35 Usha B Instructor JNNCE, Shimoga
36 Harshala Nitin Patil Technical assistant K j Somaiya institute of technology
K S R Institute For Engineering and
37 T.Chitra Lab Instructor Technology
38 Shahina Lab instructor Sambhram institute of technology
39 Sherly P J Administrative Assistant CHRIST (Deemed to be University)
KSR Institute for Engineering and
40 SALINI S Lab Assistant Technology
41 MYTHILI R Office Assistant Kongu Engineering College
42 V SHAKTHIVEL System manager Kongu Engineering college
43 Madhan Ramkumar K Record Clerk Providence college for women
Second Division Clerk
44 Prathibha A P E S college of Engineering
45 Vimaladevi M Data Entry Operator Kongu Engineering college
46 Vanitha H k Instructor P E S College of Engineering
47 K. T.ARUN Technical Assistant Kongu Engineering college
48 S Lingeshwaran Technical Assistant Kongu Engineering college
49 Katakam Srinu Librarian Sasi Institute of Technology & Engineering
50 Thangamuthu R System Administrator Kongu Engineering college
51 Amit Ajit Naik Superintendent National Institute of Technology Goa
k S R Institution for Engineering and
52 A.S.Geetha Programmer Technology
53 Savitha S Data Entry Operator kongu engineering college
54 M. Jothi Basu Director Alagappa University
55 Mohan. V Technical assistant Kongu Engineering college
Kongu Engineering College -
56 Gomathi M Technical Assistant Perundurai,Erode
57 karthika k Clerical Assistant Alagappa University
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58 S.Karthick Technical Assistant Kongu Engineering college
59 Durga D Lab Asistant Avinashilingam Institute
60 Suganya S Administrative Assistant Sona College of Technology
61 Ujjwala Rupesh Dhumal PA To Director Symbiosis Institute of Technology
Data Entry Operator
62 G S C V Padmakar (DEO) Sri Vasavi Engineering College
63 Josline Mitchel Pinto Junior Assistant Clerk St Joseph Engineering College
64 Venkateswarlu Dasari Lab Technician Sambaram institute of technology
65 Mrs D Kavitha Computer Lab Instructor Panimalar Engineering College
Nandha Engineering College (Autonomous)
66 R.Thangavel Lab Instructor Erode
67 Guru prasad sahoo Accounts Superitendent IIT, Bhubaneswar
Madan Mohan Malaviya University of
68 Pradeep Kant Singh Assistant Registrar Technology, Gorakhpur
69 G. Karthikeyan Lab Technician Sona College of Technology
70 P Vanitha Record Assistant Vidya Jyothi Institute of Technology
71 R. Gopal Technical Assistant Kongu Engineering College
Rajarambapu Institute of Technology,
72 Anil Jagannath Kate Laboratory Assistant Rajaramnagar
73 V.Kokilavani Technical Assistant Kongu Engineering College
74 M. Andal Programmer KSRIET
75 Mohammad Yakub Pasha Computer Operator Chaitanya Bharathi Institute of Technology
76 N.Gayathri Technical Assistant Kongu Engineering College
Shri Sant Gajanan Maharaj College of
77 Sunil Vilasrao Shelke Clerk Engineering Shegaon
78 Divya Lobo Jr. Asst. Clerk St. Joseph Engineering College
79 JESURAJ P.J Secretarial Assistant Sona College of Technology (Autonomous)
80 Chandra Sekhar Kunchala Computer Operator Mahatma Gandhi Institute of Technology
81 Kanchan Honale Office cum Lab Assistant SSGMCE,Shegaon
82 S.PALRAJ Department Assistant National Engineering College,
83 VEEPURU SURENDRA Assistant Programmer Mahatma Gandhi Institute of Technology
TECHNICAL
84 C.DINESHKUMAR ASSISTANT KONGU ENGINEERING COLLEGE
85 Kandasamy J Assistant Programmer National Engineering College
86 Ravindranath Avaduta Assistant Programmer Mahatma Gandhi Institute of Technology
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87 Menisha A Lab Technician Sona college of Technology
Rajarambapu Institute of Technology
88 sagar vilas patil lab assistant Rajramnager
KONGU ENGINEERING COLLEGE,
89 Palanisamy C. INSTRUCTOR PERUNDURAI
K S R Institute for Engineering and
90 K.Divyasaran Lab Assistant Technology
91 P Lakshmi Padmaja Office Assistant University of Hyderabad
92 Kadiyala Mahesh Programmer Sasi Institute of Technology &Engineering
93 R.Manickasundaram Sr.Technical Assistant Kongu Engg. College
Avinashilingam Institute for Home science
94 S. Sudha Laboratory Assistant and Higher Education for Women
95 Chandrika diwakar Clerk, lab instructor Sambhram Institute of technology
Madanapalle Institute of Technology &
96 Bharath Kumar Jonnagadla Office Assistant Science
Avinashilingam institute for home science
97 Chitra J Lab Assistant and higher education for women
DEPARTMENT
98 BAIRAVI S ASSISTANT NATIONAL ENGINEERING COLLEGE
99 Rakshitha C Office Clerk Sambhram Institute of Technology
100 M Harinath Computer Operator MGIT College, Gandipet
MAHATMA GANDHI INSTITUTE OF
101 K SUJANA Assistant Programmer TECHNOLOGY
JUNIOR ASSISTANT-
CUM-COMPUTER MAHATMA GANDHI INSTITUTE OF
102 VEERESH KUMAR K OPERATOR TECHNOLOGY
Avinashilingam institute for home science
103 Priyadharshini A Laboratory Assistant and higher education for women
CBIT(Chaitanya Bharathi Institute of
104 Mallela Kishore Computer Operator Technology),Gandipet
105 V Sri Santhi Lab Programmer Vidja Jyothi Institute of Technology
Shri Sant Gajanan Maharaj College of
106 Dnyaneshwar Baldev Thakare Clerk Engineering
107 P.Krishnamoorthi Lab technician Sona college of technology
108 SelvaKumar.P Lab Technician Sona college of Technology
109 Kalpana Balaji Executive Rajalakshmi Engineering College
110 Sarathy V Lab Technician Sona College of Technology
111 U.SIVASAMY Technical assistant Kongu engineering college
112 S.V.RANGARAJ Instructor Kongu Engineering College
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KONGU ENGINEERING COLLEGE,

113 MURUGESAN T INSTRUCTOR PERUNDURAI
114 Ramani P Technical Assistant Kongu engineering college
AVINASHILINGAM institute for home
115 M.KAMALANATHAN Multi Task Executive science and higher education for women
LOWER DIVISION DON BOSCO COLLEGE OF
116 | EDLINA THEREZA SALEMA CLERK ENGINEERING
M. P. Nachimuthu M. Jaganathan
117 Sathiya T Lab technician Engineering College
118 Varsha S B Lab instructor Sambhram institute of technology
M.p.Nachimuthu M.jaganathan Engineering
119 Sathiya.p Lab technician college
Nagarjuna College of Engineering and
120 Syeda Ayesha Tabassum Office Assistant Technology
Nagarajuna College of Engineering and
121 Narayana Murthy C M Office Assistant Technology
Nagarjuna College of Engineering and
122 Nagesh P Office Assistant Technology
123 Sri Pallavi Vinjamuri Tr. Secretarial Assistant Sona College of Technology
M.P.Nachimuthu M.Jaganathan Engineering
124 B.REVATHI ACCOUNTANT College
M.P.NACHIMUTHU M.JAGANATHAN
125 SIVAKUMAR P LAB TECHNICIAN ENGINEERING COLLEGE
EERLAPATI PRAKASARA SASI INSTITUTE OF TECHNOLOGY &
126 RAO JUNIOR ASSISTANT ENGINEERING
Nagarjuna College of engineering and
127 Lokesh RA Lab Instructor technology
Nagarjuna College of Engineering and
128 Spoorthy S Placement Executive Technology
CHAITANYA BHARATHI INSTITUTE
129 Y. CHANDRA SEKHAR ASST.PROGRAMMER OF TECHNOLOGY (Autonomous))
130 Astha Solanki Executive KIET Group of Institutions
131 sushil vichare Lab A. Thakur College of engg.tech.
Nagarjuna College of Engineering &
132 MANOHARA K S Office Assistant Technology
Nagarjuna College Of Engineering And
133 MEHAR AFROZ Programmer Technologye
134 Ferhana kausar Lab Instructor NCET
KONGU ENGINEERING COLLEGE,
135 D.SATHEESH Sr.Tech.Asst PERUNDURALI
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Nagarjuna College of Engineering &

136 Munikrishnappa m Lab attender Technology
Rakeshbhai Pravinbhai

137 Brahmbhatt Admin Executive Institute of Pharmaceutical Sciences

Rajarambapu Institute of Technology,
138 Gunvant Dattu Chavan Technocal Assistant Rajaramnagar
139 P Manivannan Lab Instructor Panimalar Engineering college
140 Mohini Pal Executive KIET Group of Institutions
141 Prakash R TECHNICIAN Sona college of technology

Nagarjuna College of engineering and
142 Nabisaheb Gulbarga System Administrator technology

Nagarjun College of Engineering
143 Muralidhar Hardware Engineer &Technology
Hardware and

144 V. Chidambaram Networking Engineer Ncet
145 Diksha Kori Demonstrator GGITS
146 B Shirisha Lab Instructor Sambharam Institute Of College
147 Aslam Pasha Instructor NCET

Rajarambapu Institute of Technology,
148 Mr. Swapnil Shashikant Patil Lab Assistant Rajaramnagar

Rajarambapu Institute of
149 Aniruddha Ashok Patil Laboratory Assistant technology,Rajaramnagar
KSR Institute for Engineering and

150 Chitra T Lab Assistant Technology
151 K V Mahesh kumar Technician Mahatma Gandhi Institute of Technology

P E S College of Engineering Mandya
152 Madan kumar H Tutor Karnataka

Shree Santkrupa Institute Of Engineering &
153 Subhash Nagesh Thorat Lab Assistant Technology Ghogaon Tal - Karad
154 Sandip Shahaji Patil Lab Assistant Rajarambapu Institute of Technology
155 Sandya B M INSTRUCTOR P E S College of Engineering Mandya
Shree santkrupa institute of engineering and
156 Dattatray Madhukar Kale Lab assistant technology ghogaon.tal karad
G Narayanamma Institute of Technology
157 P N V Varalaxmi programmer and Science
158 Peethala Ravishankar Technician Grll MGIT
Thakur College of Engineering and

159 Tushar Dilip Jagdale Sr. Clerk Technology

Nagarjuna College of engineering and
160 Anusha N Office assistant technology
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161 P Sridevi Lab Asst. GNITS
162 R.Ramya Teachnical assistant Kongu engineering college
Avinashilingam Institute for home science
163 S. Sandhya Multi Task Assistant and higher education for women
164 Anandan .S Technical assistant KSR educational institutions
165 Kavita Singh Assistant Librarian KIET Group of Institutions
KIET Group of Institutions-Ghaziabad-
166 Navindra Kumar Officer Delhi-NCR
assistant administration madanapalle institute of technology and
167 hemakiran u officer science
M.P.Nachimuthu M.Jaganathan Engineering
168 Gomathi G lab teachnician College
169 Kaviya Admin Executive Hindusthan College of Arts & Science
170 Mita Nagvekar Laboratory assistant Angel Institute of Technology and Design
Library information
171 Meenakshi Garg officer KIET Group Of Institution
Library information
172 Pawan Kumar officer KIET Group Of Institution
173 Thangavel P Office Assistant Kongu Engineering College
174 P. Narsimha Lab Assistant Mahatma Gandhi Institute of Technology
175 Radha Reddy Lab assistant GNIS
Nagarjuna College of Engineering and
176 Brunda N HR Technology
Executive Assistance-
177 Shrikant Sharma Academic Support KIET GROUP OF INSTITUTIONS
178 Sandeepa Library Assistant St Joseph Engineering College
179 Deepak Khokade Lab Assistance Rajarambapu Institute of Technology
KNOWLEDGE INSTITUTE OF
180 Mr.R Kiruthigainathan LAB TECHNICIAN TECHNOLOGY
181 K.Murugesan INSTRUCTOR KONGU ENGINEERING COLLEGE
NAGARJUNA COLLEGE OF
182 Shivamurthy R FDA ENGINEERING AND TECHNOLOGY
K.J.Somaiya Institute of Technology, Sion-
183 Sunita Tikekar Technical Assistant Mumbai
Junior assistant Cum
184 Pasula Chandrashekhar Computer Operator Mahatma Gandhi institute of technology
185 T. Vijaya Computer Operator CBIT
Hindusthan college of Engineering and
186 Pugalmani Lab Technician Technology
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187 Nagulapally Narsing Rao Computer Operator Mahatma Gandhi Institute of Technology
188 Kishor Baburao Mugale Technical Assistant K J Somaiya Institute of Technogy
Avinashilingam Institute for Home science
189 P. Elackiya Multi Task Assistant and Higher education for women
Hindusthan college of engineering and
190 Mohammed Ali Jinna H System administrator technology
Hindustan college of engineering and
191 Prem Kumar Lab technician technology
Nagarjuna College of Engineering and
192 Sahana N Office Assistant Technology (NCET), Karnataka
Hindusthan College of Engineering and
193 Ashok kumar D Lab Technician Technology, Coimbatore
194 Dr. C.Sumathi Production Executive Alagappa University
195 Ajinkya Shrihari Salgaonkar Laboratory Assistant Agnel Institute of Technology and Design
196 R.Kamatchi RJ cum Editor Alagappa University
Avinashilingam Intitute for Home Science
197 Chandra Prabha.S Multi Task Assistant and Higher Education for Women
Avinashilingam Intitute for Home Science
198 K.Kalaivani Data Entry Operator and Higher Education for Women
199 | Teena Mascarenhas e Braganza UDC Don Bosco College of Engineering
Hindusthan College of Engineering and
200 R.Manikandan Lab Technician Technology, Coimbatore
201 S. Karun Kumar Lab Assistant Sasi Institute of Technology & Engineering
Hindusthan College of Engineering and
202 Ganeshan A Lab Technician Technology
Hindusthan Collect of Engineering and
203 Marimuthu S Lab Technician Technology
Avinashilingam Institute For Home Science
204 DevikarajiS Multi Task Assistant and Higher Education for Women
Mahatma Gandhi Institute of Technology,
205 M Thrivikrama Rao Tech Grade-II Gandipet, Hyderabad
206 Priyadharshini V Lower Division Clerk Avinashilingam University
Avinashilingam Institute for Home Science
207 R.saranya Multi Task Assistant and Higher Education for Women
Avinashilingam Institute for Home Science
208 J.sabina banu Lower Division Clerk and Higher Education for Women
Avinashilingam Institute for Homescience
209 Aarthi R Lower Division Clerk and Higher education for women
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Vishwakarma Institute of Information

210 Vanita Kulkarni Office Superintendent Technology
211 Dhanapal p STORE INCHARGE Knowledge Institute of Technology
212 Prasanth P Lab Technician Knowledge Institute of Technology
213 Hanumant Tukaram Sawant Junior Clerk Bract's viit
214 Govindaraju p Lab Technician Knowledge Institute of Technology
215 Sathiyaseelan M Multitask Executive Avinashilingam
216 | Parmar Hemlatta Premchandbhai Office Assistant Parul Institute of Technology
217 P. Vasavi Viswanathan Administrative Assistant Sona College of Technology
Hindusthan College of Engineering &
218 P. Mani Network Administrator Technology
219 V.Masilamani Multi Task Assistant Avinashilingam Institute for Home Science
Hindustan college of engineering and
220 N Nagaraj Lab Technician technology
221 Kavita Amar Pashte Technical Assistant K. J. Somaiya Institute of Technology
Avinashilingam Institute for Home science
222 P. Ranjitha Laboratory Assistant and Higher education for women
Rajarambapu Institute of Technology,
223 Ganesh Shamrao Madale Laboratory Assistant Rajaramnagar
Avinashilingam Institute for Home Science
224 C.prabhavathi . Multi Task Assistant and Higher Education for Women
Hindusthan College of Engineering and
225 S.Varadarajan Lab Technician Technology
Avinashilingam institute for home science
226 M Thenmozhi . Multi Task Assistant and higher education
227 B Satyanarayana Technician Mahatma Gandhi Institute of Technology
Nagarjuna College of Engineering &
228 Chaitra S PS to Principal Technology
229 Jothi murugan Chellamuthu Technical Assistant knowledge institute of technology
Avinashilingam Institute for home science
230 Kannammal T.A Lab Assistant and Higher Education for women
Avinashilingam Institute for Home Science
231 Muthulakshmi M Laboratory Assistant for Higher Education for Women
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Sample Certificate

Avinashilingam Institute for Home Sclence and Higher Education for Women
Deemed to be University Estd.ufs 3 of UGC Act 1956, Category A by MHRD
Re-accredited with "A++' Grade by NAAC. CGPA 3.65/4,Category | by UGC

Coimbatore-641043, TamilNadu, India

AlIU - Avinashilingam Institute - Academic & Administrative Development Centre
(AlU-Al-AADC)

Certificate No: AlU - Al - AADC/ 2023 - 2024 /10/012

CERTIFICATE OF PARTICIPATION

This is to certify that

Mrs. Arati Tikare
Computer lab Instructor, Department of Computer Science and Engineering
Jawaharlal Nehru National College of Engineering - [INNCE],Shimoga, Karnataka

has participated in the Tenth Short-Term Capacity Building Programme on
Microsoft Suite Essentials for Office Administration

conducted by AlU - Avinashilingam Institute — Academic & Administrative Development Centre (AIU - Al- AADC)
from 14/12 /2023 to 16/12/2023 and her performance was Excellent.

X dEn. P 8 Nowsalyn ﬁ""*f-‘"

Dr. K. Ramya Dr. Amarendra Pani Dr. Pankaj Mittal Dr. S.Kowsalya r. V. Bharathi Harishankar
Nodal Officer, AIU-Al-AADC & Joint Director & Head Secretary General Registrar ~ Vice Chancellor
Programme Coordinator Research Division, AIU AlU Avinashilingam Institute Avinashilingam Institute
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Avinashilingam Institute for Home Science and Higher Education for Women

AIU-AI-AADC

10™ Capacity Building-Programme on
‘ Microsoft Suite Essentials for Office Administration’
14.12.2023 - 16.12.2023

Day Sessions Trainer/Resource Person
1 Microsoft Word Priyanka C
(Document Creation) Technical Facilitator cum Guest lecturer
Email : Priyanka8530@gmail.com
Mobile: 9843591414
2 Microsoft Excel Bishakha Anand
(Spreadsheet Applications) Project Coordinator cum Technical Trainer
Quadrasystems.net (India) Private Limited
Email : bishaka.a@quadrasystems.net
Mobile : 9974118327
3 PowerPoint Design and Bishakha Anand

Collaboration

Microsoft Teams & One Drive

Project Coordinator cum Technical Trainer
Quadrasystems.net (India) Private Limited

Email : bishaka.a@quadrasystems.net
Mobile : 9974118327

Praveen Poulose E
Engineer - Cyber Security Group
Quadrasystems.net (India) Private Limited

Email : praveen.p(@quadrasystems.net
Mobile :7812025576
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Avinashilingam Institute for Home Science and Higher Education for Women |
Deemed to be University Estd. u/s 3 of UGC Act 1956, Category A by
MHRD Re-accredited with 'A++' Grade by NAAC.CGPA 3.65/4,
Category I by UGC Coimbatore-641 043, Tamil Nadu, India

AIU Avinashilingam Institute
Academic and Administrative Development Centre
(AIU-AT-AADC)

X Short Term Capacity Building Programme
on

““ Microsoft Suite Essentials for Office Administration ”

14.12.2023 to 16.12.2023

Mode : Online
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ABOUT THE INSTITUTE

Avinashilingam Institute for Home Science and Higher Education for Women -
the epitome of higher education is one of the premier institutions in India well
known for its commitment towards the empowerment of women through value
based and holistic education. The institute follows educational ideals of Sri
Ramakrishna, Holy Mother Sri Saradamani Devi, Swami Vivekananda and
Mahatma Gandhiji. The institute is one of the significant contributions of
Padma Bhushan, Dr. T. S. Avinashilingam, an illustrious educationist,
freedom-fighter and Gandhian and Dr. Rajammal P. Devadas, the world-
renowned nutritionist.

The Institute had its humble beginning in the year 1957 as Sri Avinashilingam
Home Science College for Women and has been conferred the Deemed to be
University by MHRD in 1988. Few of the recent accolades of the Institute
includes: A++ with CGPA of 3.65/4 by NAAC; 84t Rank in NIRF, 5th Rank
under the category of ‘University & Deemed to be University (Govt. & Govt.
Aided) Technical’in ARITA —2021.

Presently, the institution is progressing towards ‘beyond-excellence’ under the
able guidance and leadership of Dr.T. S. K. Meenakshi Sundaram, Managing

Trustee and Chancellor, Dr. V. Bharathi Harishankar, Vice Chancellor
and Dr. S. Kowsalya, Registrar.

ABOUT ASSOCIATION OF INDIAN UNIVERSITIES

Association of Indian Universities (AIU) is an apex inter university representative
body of universities and other higher education institutions in the country.
Established in 1925 as the Inter University Board (IUB) of India, it acquired its
legal status as a registered society in 1967 under the Societies Registration Act
1860 and was rechristened as Association of Indian Universities (AIU) in 1973.
AIU is the second oldest university association in the world next to the
Association of Commonwealth Universities which was established in 1913.
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It has the distinct feature of having the largest network of universities and other HEIs
under its ambit with 981 Members which includes 16 Associate Members of Foreign
Countries. The membership of AIU includes all types of universities e.g.,
Conventional Universities, Open Universities, Deemed to be Universities, State
Universities, Central Universities, Private Universities and Institutes of National
Importance.

In addition to Indian Universities, Universities / Institutes from Bangladesh, Bhutan,
Republic of Kazakhstan, Malaysia, Mauritius, Nepal, Thailand, United Arab Emirates
and United Kingdom are its Associate Members. Since its inception AIU has played a
very significant role in the development of Education in the Country.

Some of the eminent scholars and visionary leaders like Dr Sarvepalli Radhakrishnan, Dr
Shyama Prasad Mukherjee, Dr Zakir Hussain, Sir. A L. Mudaliar have given leadership
to AIU. During such a long journey, AIU has carved a niche for itself by serving the
Ministry of Education, Govt. of India as a research-based policy advisory body. Being
an apex institution, it constitutes an integral part of all major decision-making
committees and commissions in the country

As an academic ‘think tank’ organization, AIU supports the Government as research-
based policy advisory body with the wider mandate of taking up research projects on
higher education policy and capacity building. It also acts as a bureau of information
on higher education; liaise with international bodies and universities for
internationalization of Indian higher education among many others. The Vision of
AIU is to emerge as a dynamic service and apex advisory organization in India by
undertaking initiatives and programmes which could strengthen and popularize Indian
higher education as leading-edge system in the world and promote greater national and
international collaboration in Higher Education, Research, Extension, Sports, Youth
and Cultural Activities.

It is bestowed with the mission of promoting and representing the Indian Universities
and other higher education institutions through strong liaison with the government and
National/International organizations, sister associations world over and establish
liaison between/among universities through active support, cooperation and
coordination among the member universities and all its stakeholders for quality
education, research and other academics and extension activities.
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ABOUT THE CENTRE

ATIU—-Avinashilingam Institute - Academic and Administrative Development
Centre (AIU-AI-AADC) has been initiated by the institute in association with
Association of Indian Universities (AIU) as a step towards training the human
resources of higher education institutions. The specific objectives of the centre

are:

Facilitate learning through Performance Improvement Programmes for
different groups (Administrators/Teaching Faculty/Non-Teaching
Research Scholars/Technical Personnel) towards progression based on their

career stages.
Enable continuous learning through rigorous need-based training
sessions

Sensitize stakeholders on recent developments in higher education
system in the country and across the world.

Equip academic / administrative / technical / information personnel
with the requisite skills on ICT to handle their work effectively.

Develop integrity and professional ethics among higher education
personnel.

Strengthen the human capital of the country with right attitude,
skills, and knowledge

VISION

To facilitate value-based transition towards changing higher education
ecosystem through continuous capacity building.

MISSION

To impart ICT enabled training to human resources of higher education
institutions thereby preparing themselves towards Education 5.0.
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ABOUT THE PROGRAMME

In an ever-evolving digital landscape, proficiency in Microsoft Suite has become indispensable for
efficient office administration. The workshop, titled "Microsoft Suite Essentials for Office
Administration," is crafted to empower office professionals with the fundamental skills neededto
navigate the core applications — Word, Excel, PowerPoint, Teams, and OneDrive. Over the course
of the workshop, participants will delve into practical insights and hands-on training, ensuring
they are equipped with the essential knowledge to streamline office operations.

The journey begins with Microsoft Word, where participants will grasp document creation,
formatting, and collaborative editing, laying the foundation for effective communication. Excel
essentials follow, unraveling the power of spreadsheets, formulas, and data analysis techniques,
fostering data-driven decision-making. The PowerPoint segment focuses on crafting engaging
presentations with impactful visuals, enhancing communication and presentation skills.

The workshop then transitions to collaborative tools, delving into Microsoft Teams, where
participants learn effective communication, file sharing, and collaboration in a virtual workspace.
Finally, OneDrive takes center stage, enlightening participants on cloud-based storage, file
organization, and seamless access to documents from any device.

This comprehensive workshop is designed to elevate office administration by instilling confidence
in Microsoft Suite essentials, ensuring that participants are well-versed in these indispensable
tools for modern workplace efficiency and collaboration.

OBJECTIVES

A\

Learn document creation and formatting in Microsoft Word for effective
communication.

Acquire fundamental Excel skills for data organization and analysis.

Create engaging presentations with impactful visuals using PowerPoint.

Engage in hands-on exercises for immediate skill application.

Streamline office tasks with Microsoft Suite for enhanced efficiency.

Explore virtual collaboration features for effective teamwork and communication.

Master OneDrive for seamless document storage and access from any device.

YV V.V V V V V

Prepare for the digital workplace with essential modern office tools.
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PROGRAMME SCHEDULE

Day 1: Document Creation

Session 1: Microsoft Word Basics

Introduction to Microsoft Word Interface

Creating and Saving Documents

Ribbon Interface, Quick Access Toolbar, Customising Status Bar, Search
Bar

Session 2: Document Formatting and Styles

Text Formatting: Text Selection, Fonts, Colors, and Sizes, Advanced Text
Effects

Paragraph Formatting: Alignment, Line Spacing, and Indents
Introduction to Styles for Consistent Document Formatting

Session 3: Creating Professional Documents
Working with Headers and Footers
Page Layout and Sections, Tables and Graphics for Visual Appeal
Print Preview and Printing Documents

Session 4: Collaboration and Productivity Tools

Track Changes and Comments, Collaborative Editing and Review
Mail Merge for Efficient Bulk Document Creation

Time-Saving Shortcuts and Tips, Automation with Macros, Document
Templates

Day 2: Spreadsheet Applications

Session 1: Navigation of the Excel Interface

» Introduction to Excel Tab Interface, Excel Workbook Screen
» Ribbon interface, Quick Access Toolbar, Status Bar
» Dialogue Boxes, Essential Keyboard Shortcuts
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Session 2: Tables and Conditional Formating

Understanding Lists, Sorting and Filtering Data
Creating,Modifying, Deleting Table, , Sorting Data in a Table
Conditional Formating, Creating Custom Rules, Highlighting Cells,
Using Top and Bottom Rules,

Using Data Bars, Using Colour Scales, Using Icon Sets

Session 3: Using Formulas and Creating Pivot Tables

Using Sparklines, Using Formulas in Excel

Using Functions in Excel, Insert Function Button, Working with Names
and Ranges

Creating PivotTables, Refresh Data/Change Data Source, VLOOKUP

Session 4: Collaboration and Productivity Boosters

Collaborative Editing and Sharing
Excel Automation with Macros
Power Query, Short-cuts and tips for enhancing productivity

Day 3: PowerPoint Design and Collaboration
Session 1: Creating Impactful Presentations
PowerPoint Interface and Navigation

Design Principles for Effective Presentations
Incorporating Multimedia and SmartArt

Session 2: Advanced PowerPoint Features

Animation and Transition Effects
Slide Master and Customization
Tips for Engaging Presentations
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Session 3: Collaboration with Microsoft Teams

> Introduction to Microsoft Teams
» Team Collaboration and Communication

» Integrating Teams with Office Applications

Session 4 : Managing Documents with OneDrive

» Overview of OneDrive for Business
» File Storage and Sharing

» Version Control and Document Collaboration

LIST OF RESOURCE PERSONS

s* PRIYANKA C, Technical Facilitator cum Guest lecturer

* BISHAKHA ANAND, Project Coordinator cum Technical
Trainer Quadrasystems.net (India) Private Limited

<+ PRAVEEN POULOSE E, Engineer — Cyber Security Group

Quadrasystems.net (India) Private Limited
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TARGET PARTICIPANTS

Support Staff (non-teaching staff) of Higher Education Institutions

Mode of delivery : Online
Duration : 14.12.2023 to 16.12.2023 (3 Days Programme)
REGISTRATION
REGISTRATION LINK : https:/forms.gle/kBvTWXJXnacVj96x6
FEE . FREE
AT ADVISORS

Dr. T.S. K. MEENAKSHISUNDARAM, Managing Trustee & Chancellor
Dr. V. BHARATHI HARISHANKAR, Vice Chancellor
Dr. S. KOWSALYA, Registrar

AIU ADVISORS

Dr. PANKAJ MITTAL, Secretary General, ATU
Dr. AMARENDRA PANI, Joint Director & Head, Research Division, AIU

PROGRAMME COORDINATOR

Dr. K. RAMYA,

Nodal Officer

AIU - Avinashilingam Institute- Academic & Administrative Development Centre
(AIU-AI-AADC)

Avinashilingam Institute for Home Science and Higher Education for Women
e-mail ID: aadc@avinuty.ac.in

Mobile : 8072202927
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Special thanks to:
Al Advisors
e Dr.T.S. K. Meenakshisundaram, Managing Trustee & Chancellor

e Dr. V. Bharathi Harishankar, Vice Chancellor
e Dr.S. Kowsalya, Registrar

AlU Advisors
e Dr. Pankaj Mittal, Secretary General, AlU

e Dr. Amarendra Pani, Joint Director & Head, Research Division, AlU

We extend our heartfelt gratitude to all the Invited Guests, Resource Persons, HET's,
Coordinators, Committee Members, Technical staff for their unwavering support!

We sincerely thank each attendee for their participation and enthusiasm!

Welcoming you all again in the future!

g — -

Avinashilingam Institute for Home Science and Highe

Deemed 1o be University Estd. uis 3 of UGC Act

AlU-Avinashilingam Institute-Acad
(Al
Inaugurated on Frid

Dr. K. Ramya
Nodal Officer, AIU-AI-AADC
AlU - Avinashilingam Institute- Academic & Administrative Development Centre
Avinashilingam Institute for Home Science and Higher Education for Women
Coimbatore - 641 043, Tamil Nadu, India.
e-mail ID : aadc@avinuty.ac.in
Mobile : 8072202927
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